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Figure 1: Schematic of a typical gas chromatograph. 
(From Quantitative Chemical Analysis, Daniel 
C. Harris, 8th Edition) 

Experiment 11 

 USING A GAS CHROMATOGRAPH FOR QUALITATIVE & QUANTITATIVE 
ANALYSES OF ORGANIC COMPOUNDS 

Reading: Chapter 5 (pg 109-110), Chapter 22 (pg 542-599), and Chapter 23 (pg 565-582) of 
Quantitative Chemical Analysis, 8th Edition, Daniel C. Harris. 

Objectives  

In this experiment, you will qualitatively analyze a mixture of organic compounds using a 
Vernier Mini GC and use an internal standard for quantitative analyses.  

Suggested schedule 
Lab 1 Use the mini GC for the qualitative determination of the organic compounds in an 

unknown. You will need to bring a USB flash drive to class in order to store your 
data. 

Lab 2 Determine the concentration of an analyte using an internal standard. You may wish to 
complete all required calculations before leaving the lab. You may wish to store your 
data on a USB flashdrive. 

Lab 3 Use this time to finish up Experiment 11. 
 
There are many different types of chromatography: paper chromatography, thin layer 
chromatography (TLC), liquid chromatography (LC), high-performance liquid 
chromatography (HPLC) and gas chromatography (GC). Chromatography is applied in many 
fields. Biochemists use liquid chromatography to separate proteins, and chemists use GC and 
HPLC to identify organic compounds as well as for drug testing, toxin screens and 
environmental analyses. Many forensic tests also involve chromatography. 

Gas chromatography was pioneered by Dr. Erika Cremer and her student, Fritz Prior, in 
Germany in the 1940’s. Dr. Cremer developed the theoretical basis of gas chromatography, as 
well as the first prototype of the gas chromatograph, but much of her work was destroyed by 
bombing during World War II and 
lost. The technique of gas 
chromatography was also described by 
A.J.T. Martin and R.T. James in 1952. 
GC revolutionized the field of 
chromatography and rapidly became 
an indispensible analytical technique. 
Today, GC is the premier method for 
the separation of volatile compounds, 
and gas chromatographs are the most 
widely used form of instrumentation 
in the world. A schematic of a GC is 
shown in Figure 1.  
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Figure 2: A sample gas chromatograph acquired from a mixture of acetone, 2-pentanone, and 2-
hexanone using the Vernier Mini GC. 

In GC, a volatile liquid or gaseous sample is injected through a rubber septum into a heated 
port. The vapor is swept through a heated chromatography column by the mobile phase 
(typically He or N2). As the sample mixture travels down the column, the various compounds 
present interact with the stationary phase and thus travel more slowly than the mobile phase. 
A detector is situated at the end of the chromatography column. Each eluted compound is 
seen as a peak in a chromatogram (Figure 2). The amount of time it takes for a compound to 
reach the detector after it is injected is called the retention time. A compound can often be 
identified from a mixture of chemicals by its retention time. The retention time for each 
compound will depend on various factors, including compound boiling point and polarity and 
the polarity of the stationary phase. 

 
 
 
 
 
 
 
 
 
 
 
 
 

There are two main types of gas chromatography: gas-solid adsorption chromatography and 
gas-liquid partition chromatography. In gas-solid adsorption chromatography, solid 
particulates, often composed of silica, are tightly packed into a column. Gas-liquid partition 
chromatography uses a viscous liquid chemically bonded to the inside of a capillary tube or to 
a support of solid particles. The Vernier Mini GC uses an eleven-meter-long stainless steel 
capillary column (inner diameter 0.53 mm) treated with a proprietary material called Siltek®, 
to make it unreactive. The stationary phase is a dimethyl polysiloxane polymer that coats the 
inner wall of the column. Thus, the form of GC you are using in Experiment 11 is gas-liquid 
partition chromatography. The mobile phase is air. The detector is a chemicapacitive sensor 
composed of a chip coated with a chemoselective polymer. The polymer adsorbs analytes 
exiting the column, and the adsorption is measured with detector circuitry.  

As mentioned above, several factors can affect the interaction of a compound with the 
stationary phase. More volatile compounds (i.e., compounds with a lower boiling point) tend 
to move through the column more quickly because they interact very little with the stationary 
phase and, thus, spend more time in the mobile phase. The functional groups present in the 
compound also play an important role in retention. For example, alcohols may interact with a 
polar stationary phase more than esters because alcohols can form stronger hydrogen bonds. 
Hydrogen bonding and dipole interactions are very important retention mechanisms. 
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There are many ways to obtain quantitative information from a chromatogram. Because the 
area of an analyte peak is proportional to its concentration, one can analyze a series of 
standards, and acquire a calibration curve, just as you did in Experiment 10. However, an 
easier and faster way to quantitate an unknown is to use an internal standard. This method 
requires that the identity of the analyte to be quantified is known. The procedure is as follows: 
first, the sample is spiked with a known concentration and volume of a standard (not your 
analyte!), and a chromatogram is acquired. Secondly, a second sample is prepared by mixing 
a known amount of analyte with a known amount

Aanalyte/Canalyte = F(Astandard/Cstandard)  Equation 1 

 of a standard. The chromatograms are 
acquired and the peaks are integrated to obtain the peak area. The following relationship can 
be used to obtain the amount (moles, concentration, or mass) of the analyte in the analyte 
sample.  

In Equation 1, A is peak area and C is concentration. F is called the response factor. The 
response factor takes into account the fact that the detector may respond differently to each 
analyte. It can be obtained using the second sample, where the concentration of both standard 
and analyte are known.  

PRE–LAB ASSIGNMENT 

1) Work through Example 5-4 on page 109 of your text. 
2) Complete the table below. Look up the boiling points for the solvents listed and predict the 

order in which these compounds will exit the GC column (known as elution order). Rate 
the compound you think will exit the column first with the number 1; the last compound to 
exit the column is given the number 5. 

 

Compound Boiling Point, °C Predicted elution order (1-5) 

Methyl ethyl ketone (MEK)   

Ethyl acetate   

Butyl acetate   

acetone   

methanol   
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Apparatus/Materials 
Vernier Mini GC Acetone 
LabQuest Methyl ethyl ketone (MEK) 
Logger Pro 3 or LabQuest App Ethyl acetate 
1 µL glass syringe Butyl acetate 
Kimwipes® or paper towel Methanol 

  
 

Procedure: 

Part 1:  You will be provided with aliquots of the solvents listed above and with an unknown 
mixture of solvents. Acquire a chromatogram of each solvent and of the unknown mixture. 
Follow the injection procedure below to obtain the needed data. You will need to make a total 
of six injections: one for each of the five solvents and one for the unknown mixture which 
Lab Services has prepared. Your goal is to identify the components of the mixture. 

Part 2: Your TA will provide you with a sample of a pure solvent. You will also be provided 
with acetone to use as an internal standard. You will mix the acetone with your allotted 
sample such that the concentrations of both in the mixture are known (i.e. use 1 mL each). 
You will make a second mixture in which you use 1 mL acetone, but choose a different 
volume of sample (e.g 2 mL). For this part of the experiment the volume of sample is not 
important, as this will serve as your “unknown”. However, you may need to know the total 
volume of your solution. Acquire a chromatogram for each sample. Important: after 
completing Part II, and before you leave the lab you must integrate

 

 your peaks. See 
below. 

Acquiring a Chromatogram using the Vernier Mini GC 
Important: The glass syringe is fragile and can be easily damaged. Be careful not to bend the 
needle or bend the plunger. If the plunger is accidentally pulled out of the glass barrel, 
reinserting it is extremely difficult, and sometimes impossible. Consult your TA if this 
happens. 

1. Prepare the Vernier Mini GC for data collection. 

a. Turn on the Mini GC. 
b. Connect the USB cable of the Mini GC to the USB port on the LabQuest. 
c. Choose “New” from the File menu.  
d. Click ► in LabQuest, to bring up the Temperature-Pressure profile. 
e. Set the Temperature-Pressure values to the values below. 
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*This pressure corresponds to an air flow rate of 2.7 mL/min 

f. Select “done” to initiate the Mini GC warm up. Note: A new message will read “do 
not inject until GC is ready”, and the LED on the Mini GC will be red. The Mini GC 
will take a few minutes to warm up and stabilize. When the Mini GC is ready for 
injection in Step 7, the message will read, “inject and select collect simultaneously”, 
and the LED will turn to green. Continue with Step 2 during warm up. 

2. Follow the steps below to clean and flush the syringe with acetone. Important: The glass 
syringe is fragile. Be careful not to bend the needle or bend the plunger. Never pull the 
plunger back more than 50% of its total volume. Be careful not to bend the plunger as you 
press it down. Note that the needle is partially covered with a plastic sheath. This to 
prevent your from inserting the needle too far into the injection port. If you needle is 
missing this sheath, consult your TA.  

a. Depress the plunger fully. 
b. Submerge the tip of the syringe needle into the acetone in the vial. 

c. Pull back the plunger to fill the barrel about 1/3 full of acetone. Examine the barrel of 
the syringe and estimate the amount of acetone in the barrel. 

Be careful not to hit 
the point of the syringe against the bottom of the vial, as it can be easily damaged in 
that way. 

d. Expel the liquid onto a Kimwipe or a paper towel. 
e. Repeat Steps a–d at least two times, until you are comfortable pulling up a liquid into 

the syringe and measuring the volume in the syringe barrel. Use a Kimwipe or a paper 
towel to carefully pat around the tip of the syringe needle. 

3. Follow the process in Step 4 to clean and flush the syringe with the first sample to be 
injected into the Mini GC. 

4. Collect a volume of the first sample for injection. 

a. Submerge the needle into the solution in the vial.  
b. Draw up approximately 0.1 to 0.2 µL of liquid. It is not critical that the volume be 

exact for Part I; for Part II of the experiment choose a volume and stick to it.  
c. After collecting your sample, use a Kimwipe to gently wipe the needle from barrel to 

tip. 

5. Prepare for injection and the start of data collection. You and your lab partner may wish to 
divide the tasks in this step. One person can operate the syringe and the other person can 
operate the LabQuest control. 

Start temperature 30°C 
Hold time 3 min 
Ramp rate 10°C/min 
Final temperature 75°C 
Hold time 5 min 
Total length 12.5 min 
Pressure  5.0 kPa*  
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a. When the Mini GC has reached the correct start temperature and pressure, the 
message reads, “Inject and select collect simultaneously,” and the LED on the 
Mini GC is green. 

b. To insert the needle of the syringe into the injection 
port of the Mini GC, hold the syringe with one hand 
and steady the needle with your other hand. Insert the 
needle into the injection port until the needle stop is 
fully seated, as shown in Figure 3. If the needle sticks, 
rotate the syringe slightly (and gently!) while inserting 
the needle. Don’t force the needle into the port. If 
necessary, remove the syringe needle from the 
injection port and then reinsert it. Do not depress the 
plunger yet.  

c. Simultaneously depress the syringe plunger and select 
“collect” to begin data collection. Pull the needle out of the injection port 
immediately. 

6. While the data collection proceeds, repeat Step 4 to thoroughly clean the syringe and 
needle. It may take more than three flushes to feel the syringe plunger move smoothly 
again, which is your indicator that the syringe and needle are both suitably clean. 

7. Data collection will end after ~12.5 minutes. Note: you may stop the run once you are 
sure all your peaks have completely eluted. Do not

8. Save the chromatogram (“file”, “save”, and name the file). 

 stop the run before all your peaks 
have eluted! 

9. Zoom in on a peak. Drag your stylus across the desired peak. Go to “graph”, and then 
“zoom in”. Use the stylus to select the highest point of the peak. Record the signal 
intensity (in mV) and the retention time of the peak. Repeat for all peaks. 

10. Select another sample. 

a. Click ► in LabQuest, to bring up the Temperature -Pressure profile. This profile 
will be the same as for your previous run. If you are satisfied with these values, 
select “done” to initiate the Mini GC profile. Select store (save). 

b. While the Mini GC adjusts to its Temperature-Pressure profile, rinse your syringe 
and fill with sample. 

c. After the Mini GC is ready, inject your new sample. 

11. When you have completed your final

 

 data collection run, turn off the Mini GC. Before 
you leave the lab, save all your files to your flashdrive. Also export your qmbl 
files to text files and save them onto a flashdrive. To export a qmbl file to text insert 
your flashdrive into the USB port. Open your qmbl file, go to “file”, “export”, select 
the flashdrive, rename the file, and click “ok”. 

 

 

Figure 3 
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Peak Integration 
1. Choose “peak integration” from the Analyze menu. Choose “signal”. 
2. Drag your cursor over one peak and press “magnify”.  
3. Integrate the peak. To do this drag the pointer from slightly before the peak to a point far 

enough the right such that the whole peak is selected. You should be careful and 
consistent in how you select peaks.  

4. Press “add”. Record the peak area (not % area). 
5. Repeat for all desired peaks. 
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Report (100 pts) 
 
A typed report is required for this experiment. Pay attention to the quality of your writing. 
This report should contain: 
 
1) A title page with the title of the experiment, the date, and your name. 
2) A short introduction, which includes the experimental and educational objectives of the 

experiment, a description of your samples, the measurements you made and the technique 
you used.  

3) A brief summary of the experimental procedures you used, with enough detail so that one 
of your fellow students could repeat your work. 

4) Results. For the results and discussion section you should consider/complete/discuss the 
following: 
 
Results, Part I 

a) Plot a chromatogram for each individual solvent. Label each peak with its 
retention time. (You may plot the data all together in one plot). Also provide a 
table with a summary of your data.  

b) Plot the chromatogram for your unknown mixture. Use the retention times 
determined above to identify the solvents that are present in the assigned unknown 
mixture. Do these solvents elute according to the order in which you assigned 
them in the prelab? Does elution order correspond to solvent boiling point? 
Explain why or why not this might be so. Examine the shapes of the peaks in this 
chromatogram. Do these peaks have the ideal Gaussian shape? If not, give a 
possible reason or reasons for the nonideal peak shapes. 

c) Typically, a nonreactive compound is used to measure tm, the solvent transit time. 
What compound could potentially be used in this experiment? Use the solvent 
flow rate and the column length and inner diameter (both are provided in this 
manual) to predict

d) Calculate the retention factor (capacity factor) and partition coefficient for each 
compound in your unknown.  

 tm. Assume that the stationary phase thickness is 5 µm thick. 
Based on the data you have acquired, does the calculated tm value seem 
reasonable? Use this value to acquire adjusted retention times for the components 
of your unknown. 

e) Use the width of each peak at its base (you can find this using the chromatogram 
you plotted in part (a) to calculate an average

f) Tabulate the data. Use the table below as a template.  

 value for N, the number of plates on 
the column.  
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Compound 
Boiling 

Point, °C 

Retention 
Time, 
min 

Adjusted 
Retention 
Time, min  

Retention 
Factor 

Partition 
Coefficient 

Number of 
plates on 
the column 
(N) 

Methyl ethyl 
ketone (MEK) 

      

Ethyl acetate       

Butyl acetate       

Acetone       

Methanol       

 
 

Results, Part II 
a) Using the data you acquired in Part 2, calculate F, the response factor. Hint: use 

the solvent density to find the concentration of each component of your mixture. 
Use the response factor, to calculate the concentration of the analyte in your 
“unknown”. Tabulate your results. To which analyte does the detector have a 
greater response (in terms of moles of analyte)? 

 
5) Discussion 

a) Discuss, interpret and comment on your results from parts I and II of the experiment. 
b) Discuss any problems you had in this experiment and how you addressed these 

problems. How would you change the experiment to improve the quality of the data? 
c) Is GC the only method that can be used to identify the solvents present in a mixture of 

solvents? What other method or methods could potentially be used for this purpose? 
 

6) Conclusions. What conclusions can your draw from this experiment? How would you 
improve upon this experiment? 

 
 
 



experiment 11
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 Using a Gas Chromatograph for QUAlitative & quantitative analyses of ORGANIC Compounds

Reading: Chapter 5 (pg 109-110), Chapter 22 (pg 542-599), and Chapter 23 (pg 565-582) of Quantitative Chemical Analysis, 8th Edition, Daniel C. Harris.

Objectives 


In this experiment, you will qualitatively analyze a mixture of organic compounds using a Vernier Mini GC and use an internal standard for quantitative analyses. 

Suggested schedule


Lab 1
Use the mini GC for the qualitative determination of the organic compounds in an unknown. You will need to bring a USB flash drive to class in order to store your data.

Lab 2
Determine the concentration of an analyte using an internal standard. You may wish to complete all required calculations before leaving the lab. You may wish to store your data on a USB flashdrive.

Lab 3
Use this time to finish up Experiment 11.


There are many different types of chromatography: paper chromatography, thin layer chromatography (TLC), liquid chromatography (LC), high-performance liquid chromatography (HPLC) and gas chromatography (GC). Chromatography is applied in many fields. Biochemists use liquid chromatography to separate proteins, and chemists use GC and HPLC to identify organic compounds as well as for drug testing, toxin screens and environmental analyses. Many forensic tests also involve chromatography.

[image: image3.emf] 


 


Gas chromatography was pioneered by Dr. Erika Cremer and her student, Fritz Prior, in Germany in the 1940’s. Dr. Cremer developed the theoretical basis of gas chromatography, as well as the first prototype of the gas chromatograph, but much of her work was destroyed by bombing during World War II and lost. The technique of gas chromatography was also described by A.J.T. Martin and R.T. James in 1952. GC revolutionized the field of chromatography and rapidly became an indispensible analytical technique. Today, GC is the premier method for the separation of volatile compounds, and gas chromatographs are the most widely used form of instrumentation in the world. A schematic of a GC is shown in Figure 1. 

In GC, a volatile liquid or gaseous sample is injected through a rubber septum into a heated port. The vapor is swept through a heated chromatography column by the mobile phase (typically He or N2). As the sample mixture travels down the column, the various compounds present interact with the stationary phase and thus travel more slowly than the mobile phase. A detector is situated at the end of the chromatography column. Each eluted compound is seen as a peak in a chromatogram (Figure 2). The amount of time it takes for a compound to reach the detector after it is injected is called the retention time. A compound can often be identified from a mixture of chemicals by its retention time. The retention time for each compound will depend on various factors, including compound boiling point and polarity and the polarity of the stationary phase.



There are two main types of gas chromatography: gas-solid adsorption chromatography and gas-liquid partition chromatography. In gas-solid adsorption chromatography, solid particulates, often composed of silica, are tightly packed into a column. Gas-liquid partition chromatography uses a viscous liquid chemically bonded to the inside of a capillary tube or to a support of solid particles. The Vernier Mini GC uses an eleven-meter-long stainless steel capillary column (inner diameter 0.53 mm) treated with a proprietary material called Siltek®, to make it unreactive. The stationary phase is a dimethyl polysiloxane polymer that coats the inner wall of the column. Thus, the form of GC you are using in Experiment 11 is gas-liquid partition chromatography. The mobile phase is air. The detector is a chemicapacitive sensor composed of a chip coated with a chemoselective polymer. The polymer adsorbs analytes exiting the column, and the adsorption is measured with detector circuitry. 


As mentioned above, several factors can affect the interaction of a compound with the stationary phase. More volatile compounds (i.e., compounds with a lower boiling point) tend to move through the column more quickly because they interact very little with the stationary phase and, thus, spend more time in the mobile phase. The functional groups present in the compound also play an important role in retention. For example, alcohols may interact with a polar stationary phase more than esters because alcohols can form stronger hydrogen bonds. Hydrogen bonding and dipole interactions are very important retention mechanisms.

There are many ways to obtain quantitative information from a chromatogram. Because the area of an analyte peak is proportional to its concentration, one can analyze a series of standards, and acquire a calibration curve, just as you did in Experiment 10. However, an easier and faster way to quantitate an unknown is to use an internal standard. This method requires that the identity of the analyte to be quantified is known. The procedure is as follows: first, the sample is spiked with a known concentration and volume of a standard (not your analyte!), and a chromatogram is acquired. Secondly, a second sample is prepared by mixing a known amount of analyte with a known amount of a standard. The chromatograms are acquired and the peaks are integrated to obtain the peak area. The following relationship can be used to obtain the amount (moles, concentration, or mass) of the analyte in the analyte sample. 

Aanalyte/Canalyte = F(Astandard/Cstandard)

Equation 1

In Equation 1, A is peak area and C is concentration. F is called the response factor. The response factor takes into account the fact that the detector may respond differently to each analyte. It can be obtained using the second sample, where the concentration of both standard and analyte are known. 

Pre–lab Assignment

1)
Work through Example 5-4 on page 109 of your text.


2)
Complete the table below. Look up the boiling points for the solvents listed and predict the order in which these compounds will exit the GC column (known as elution order). Rate the compound you think will exit the column first with the number 1; the last compound to exit the column is given the number 5.

		Compound

		Boiling Point, °C

		Predicted elution order (1-5)



		Methyl ethyl ketone (MEK)

		

		



		Ethyl acetate

		

		



		Butyl acetate

		

		



		acetone

		

		



		methanol

		

		





apparatus/Materials

		Vernier Mini GC

		Acetone



		LabQuest

		Methyl ethyl ketone (MEK)



		Logger Pro 3 or LabQuest App

		Ethyl acetate



		1 (L glass syringe

		Butyl acetate



		Kimwipes® or paper towel

		Methanol



		

		





Procedure:

Part 1:
 You will be provided with aliquots of the solvents listed above and with an unknown mixture of solvents. Acquire a chromatogram of each solvent and of the unknown mixture. Follow the injection procedure below to obtain the needed data. You will need to make a total of six injections: one for each of the five solvents and one for the unknown mixture which Lab Services has prepared. Your goal is to identify the components of the mixture.

Part 2: Your TA will provide you with a sample of a pure solvent. You will also be provided with acetone to use as an internal standard. You will mix the acetone with your allotted sample such that the concentrations of both in the mixture are known (i.e. use 1 mL each). You will make a second mixture in which you use 1 mL acetone, but choose a different volume of sample (e.g 2 mL). For this part of the experiment the volume of sample is not important, as this will serve as your “unknown”. However, you may need to know the total volume of your solution. Acquire a chromatogram for each sample. Important: after completing Part II, and before you leave the lab you must integrate your peaks. See below.

Acquiring a Chromatogram using the Vernier Mini GC


Important: The glass syringe is fragile and can be easily damaged. Be careful not to bend the needle or bend the plunger. If the plunger is accidentally pulled out of the glass barrel, reinserting it is extremely difficult, and sometimes impossible. Consult your TA if this happens.

1. Prepare the Vernier Mini GC for data collection.

a. Turn on the Mini GC.

b. Connect the USB cable of the Mini GC to the USB port on the LabQuest.

c. Choose “New” from the File menu. 

d.
Click ► in LabQuest, to bring up the Temperature-Pressure profile.

e.
Set the Temperature-Pressure values to the values below.

		Start temperature

		30(C



		Hold time

		3 min



		Ramp rate

		10(C/min



		Final temperature

		75(C



		Hold time

		5 min



		Total length

		12.5 min



		Pressure 

		5.0 kPa* 





*This pressure corresponds to an air flow rate of 2.7 mL/min

f.
Select “done” to initiate the Mini GC warm up. Note: A new message will read “do not inject until GC is ready”, and the LED on the Mini GC will be red. The Mini GC will take a few minutes to warm up and stabilize. When the Mini GC is ready for injection in Step 7, the message will read, “inject and select collect simultaneously”, and the LED will turn to green. Continue with Step 2 during warm up.

2.
Follow the steps below to clean and flush the syringe with acetone. Important: The glass syringe is fragile. Be careful not to bend the needle or bend the plunger. Never pull the plunger back more than 50% of its total volume. Be careful not to bend the plunger as you press it down. Note that the needle is partially covered with a plastic sheath. This to prevent your from inserting the needle too far into the injection port. If you needle is missing this sheath, consult your TA. 

a. Depress the plunger fully.


b. Submerge the tip of the syringe needle into the acetone in the vial. Be careful not to hit the point of the syringe against the bottom of the vial, as it can be easily damaged in that way.

c. Pull back the plunger to fill the barrel about 1/3 full of acetone. Examine the barrel of the syringe and estimate the amount of acetone in the barrel.

d. Expel the liquid onto a Kimwipe or a paper towel.


e. Repeat Steps a–d at least two times, until you are comfortable pulling up a liquid into the syringe and measuring the volume in the syringe barrel. Use a Kimwipe or a paper towel to carefully pat around the tip of the syringe needle.

3.
Follow the process in Step 4 to clean and flush the syringe with the first sample to be injected into the Mini GC.

4.
Collect a volume of the first sample for injection.

a. Submerge the needle into the solution in the vial. 

b. Draw up approximately 0.1 to 0.2 (L of liquid. It is not critical that the volume be exact for Part I; for Part II of the experiment choose a volume and stick to it. 

c. After collecting your sample, use a Kimwipe to gently wipe the needle from barrel to tip.

5.
Prepare for injection and the start of data collection. You and your lab partner may wish to divide the tasks in this step. One person can operate the syringe and the other person can operate the LabQuest control.


a. When the Mini GC has reached the correct start temperature and pressure, the message reads, “Inject and select collect simultaneously,” and the LED on the Mini GC is green.

b. To insert the needle of the syringe into the injection port of the Mini GC, hold the syringe with one hand and steady the needle with your other hand. Insert the needle into the injection port until the needle stop is fully seated, as shown in Figure 3. If the needle sticks, rotate the syringe slightly (and gently!) while inserting the needle. Don’t force the needle into the port. If necessary, remove the syringe needle from the injection port and then reinsert it. Do not depress the plunger yet. 

c. Simultaneously depress the syringe plunger and select “collect” to begin data collection. Pull the needle out of the injection port immediately.

6.
While the data collection proceeds, repeat Step 4 to thoroughly clean the syringe and needle. It may take more than three flushes to feel the syringe plunger move smoothly again, which is your indicator that the syringe and needle are both suitably clean.

7.
Data collection will end after ~12.5 minutes. Note: you may stop the run once you are sure all your peaks have completely eluted. Do not stop the run before all your peaks have eluted!

8.
Save the chromatogram (“file”, “save”, and name the file).

9.
Zoom in on a peak. Drag your stylus across the desired peak. Go to “graph”, and then “zoom in”. Use the stylus to select the highest point of the peak. Record the signal intensity (in mV) and the retention time of the peak. Repeat for all peaks.

10.
Select another sample.


a.
Click ► in LabQuest, to bring up the Temperature-Pressure profile. This profile will be the same as for your previous run. If you are satisfied with these values, select “done” to initiate the Mini GC profile. Select store (save).

b.
While the Mini GC adjusts to its Temperature-Pressure profile, rinse your syringe and fill with sample.

c.
After the Mini GC is ready, inject your new sample.

11.
When you have completed your final data collection run, turn off the Mini GC. Before you leave the lab, save all your files to your flashdrive. Also export your qmbl files to text files and save them onto a flashdrive. To export a qmbl file to text insert your flashdrive into the USB port. Open your qmbl file, go to “file”, “export”, select the flashdrive, rename the file, and click “ok”.

Peak Integration

1.
Choose “peak integration” from the Analyze menu. Choose “signal”.

2.
Drag your cursor over one peak and press “magnify”. 

3.
Integrate the peak. To do this drag the pointer from slightly before the peak to a point far enough the right such that the whole peak is selected. You should be careful and consistent in how you select peaks. 

4.
Press “add”. Record the peak area (not % area).

5.
Repeat for all desired peaks.


Report (100 pts)


A typed report is required for this experiment. Pay attention to the quality of your writing. This report should contain:


1) A title page with the title of the experiment, the date, and your name.


2) A short introduction, which includes the experimental and educational objectives of the experiment, a description of your samples, the measurements you made and the technique you used. 


3) A brief summary of the experimental procedures you used, with enough detail so that one of your fellow students could repeat your work.


4) Results. For the results and discussion section you should consider/complete/discuss the following:


Results, Part I


a) Plot a chromatogram for each individual solvent. Label each peak with its retention time. (You may plot the data all together in one plot). Also provide a table with a summary of your data. 


b) Plot the chromatogram for your unknown mixture. Use the retention times determined above to identify the solvents that are present in the assigned unknown mixture. Do these solvents elute according to the order in which you assigned them in the prelab? Does elution order correspond to solvent boiling point? Explain why or why not this might be so. Examine the shapes of the peaks in this chromatogram. Do these peaks have the ideal Gaussian shape? If not, give a possible reason or reasons for the nonideal peak shapes.


c) Typically, a nonreactive compound is used to measure tm, the solvent transit time. What compound could potentially be used in this experiment? Use the solvent flow rate and the column length and inner diameter (both are provided in this manual) to predict tm. Assume that the stationary phase thickness is 5 µm thick. Based on the data you have acquired, does the calculated tm value seem reasonable? Use this value to acquire adjusted retention times for the components of your unknown.

d) Calculate the retention factor (capacity factor) and partition coefficient for each compound in your unknown. 

e) Use the width of each peak at its base (you can find this using the chromatogram you plotted in part (a) to calculate an average value for N, the number of plates on the column. 


f) Tabulate the data. Use the table below as a template. 

		Compound

		Boiling Point, °C

		Retention Time, min

		Adjusted Retention Time, min 

		Retention Factor

		Partition Coefficient

		Number of plates on the column (N)



		Methyl ethyl ketone (MEK)

		

		

		

		

		

		



		Ethyl acetate

		

		

		

		

		

		



		Butyl acetate

		

		

		

		

		

		



		Acetone

		

		

		

		

		

		



		Methanol

		

		

		

		

		

		





Results, Part II

a)
Using the data you acquired in Part 2, calculate F, the response factor. Hint: use the solvent density to find the concentration of each component of your mixture. Use the response factor, to calculate the concentration of the analyte in your “unknown”. Tabulate your results. To which analyte does the detector have a greater response (in terms of moles of analyte)?

5) Discussion

a) Discuss, interpret and comment on your results from parts I and II of the experiment.


b) Discuss any problems you had in this experiment and how you addressed these problems. How would you change the experiment to improve the quality of the data?

c) Is GC the only method that can be used to identify the solvents present in a mixture of solvents? What other method or methods could potentially be used for this purpose?

6) Conclusions. What conclusions can your draw from this experiment? How would you improve upon this experiment?

Figure 1:	Schematic of a typical gas chromatograph. (From Quantitative Chemical Analysis, Daniel C. Harris, 8th Edition)







Figure 3







Figure 2:	A sample gas chromatograph acquired from a mixture of acetone, 2-pentanone, and 2-hexanone using the Vernier Mini GC.
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